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• The information in this document is current as of 10.09. 2004. The information is subject to change
without notice. For actual design-in, refer to the latest publications of NEC Electronics data sheets or
data books, etc., for the most up-to-date specifications of NEC Electronics products. Not all products
and/or types are available in every country. Please check with an NEC sales representative for
availability and additional information.

• No part of this document may be copied or reproduced in any form or by any means without prior
written consent of NEC Electronics. NEC Electronics assumes no responsibility for any errors that
may appear in this document.

• NEC Electronics does not assume any liability for infringement of patents, copyrights or other
intellectual property rights of third parties by or arising from the use of NEC Electronics products
listed in this document or any other liability arising from the use of such NEC Electronics products.
No license, express, implied or otherwise, is granted under any patents, copyrights or other intellectual
property rights of NEC Electronics or others.

• Descriptions of circuits, software and other related information in this document are provided for
illustrative purposes in semiconductor product operation and application examples. The incorporation
of these circuits, software and information in the design of customer's equipment shall be done
under the full responsibility of customer. NEC Electronics no responsibility for any losses incurred by
customers or third parties arising from the use of these circuits, software and information. 

• While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics
products, customers agree and acknowledge that the possibility of defects thereof cannot be eliminated
entirely. To minimize risks of damage to property or injury (including death) to persons arising from
defects in NEC Electronics products, customers must incorporate sufficient safety measures in their
design, such as redundancy, fire-containment and anti-failure features.

• NEC Electronics products are classified into the following three quality grades: “Standard”, “Special”
and “Specific”.

The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated “quality assurance program” for a specific application. The recommended applications of
NEC Electronics product depend on its quality grade, as indicated below. Customers must check the
quality grade of each NEC Electronics product before using it in a particular application.

"Standard": Computers, office equipment, communications equipment, test and measurement
equipment, audio and visual equipment, home electronic appliances, machine tools,
personal electronic equipment and industrial robots.

"Special": Transportation equipment (automobiles, trains, ships, etc.), traffic control systems,
anti-disaster systems, anti-crime systems, safety equipment and medical equipment 
(not specifically designed for life support).

"Specific": Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, 
life support systems and medical equipment for life support, etc.

The quality grade of NEC Electronics products is “Standard” unless otherwise expressly specified in
NEC Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in
applications not intended by NEC Electronics, they must contact NEC Electronics sales representative
in advance to determine NEC Electronics 's willingness to support a given application.

Notes: 1. " NEC Electronics" as used in this statement means NEC Electronics Corporation and 
also includes its majority-owned subsidiaries.

2." NEC Electronics products" means any product developed or manufactured by or for NEC
Electronics (as defined above).

M8E 02.10
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Regional Information

Some information contained in this document may vary from country to country. Before using any NEC
product in your application, please contact the NEC office in your country to obtain a list of authorized
representatives and distributors. They will verify:

• Device availability

Ordering information

Product release schedule

Availability of related technical literature

Development environment specifications (for example, specifications for third-party tools and
components, host computers, power plugs, AC supply voltages, and so forth)

Network requirements

In addition, trademarks, registered trademarks, export restrictions, and other legal issues may also vary
from country to country.

NEC Electronics America Inc.
Santa Clara, California
Tel: 408-588-6000

800-366-9782
Fax: 408-588-6130

800-729-9288

NEC Electronics (Europe) GmbH
Duesseldorf, Germany
Tel: 0211-65 03 1101
Fax: 0211-65 03 1327

Sucursal en España
Madrid, Spain
Tel: 091- 504 27 87
Fax: 091- 504 28 60

Succursale Française
Vélizy-Villacoublay, France
Tel: 01-30-67 58 00
Fax: 01-30-67 58 99

NEC Electronics Hong Kong Ltd.
Hong Kong
Tel: 2886-9318
Fax: 2886-9022/9044

NEC Electronics Hong Kong Ltd.
Seoul Branch
Seoul, Korea
Tel: 02-528-0303
Fax: 02-528-4411

NEC Electronics Singapore Pte. Ltd.
Singapore
Tel: 65-6253-8311
Fax: 65-6250-3583

NEC Electronics Taiwan Ltd.
Taipei, Taiwan
Tel: 02-2719-2377
Fax: 02-2719-5951

Filiale Italiana
Milano, Italy
Tel: 02-66 75 41
Fax: 02-66 75 42 99

Branch The Netherlands
Eindhoven, The Netherlands
Tel: 040-244 58 45
Fax: 040-244 45 80

Branch Sweden
Taeby, Sweden
Tel: 08-63 80 820
Fax: 08-63 80 388

United Kingdom Branch
Milton Keynes, UK
Tel: 01908-691-133
Fax: 01908-670-290

•

•

•

•

•
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Preface

Target Reader This manual is intended for users who use the PG-FPL when designing and
developing a system using an NEC Electronics on-chip flash memory micro-
controller.

Purpose This manual is intended to give users an understanding of the basic specifi-
cations and correct use of the PG-FPL. By using the PG-FPL, programs can
be easily erased from or written to the flash memory of an NEC on-chip flash

memory microcontroller, or can be verified on WindowsTM screens, while the
microcontroller is mounted on the user board.

Organization This manual includes the following chapters:

• Overview

• Hardware installation

• Software installation

• Using the GUI software

• Example of use

• Connectors and cables

• Notes on target systems

• Circuit diagrams

• Troubleshooting

• Appendix

Reading this Manual To understand the overall functions and usage of the PG-FPL, read this
manual in the order of CONTENTS.
Be sure to read CHAPTER 4 USING THE GUI SOFTWARE because this
chapter presents important information for using the PG-FPL.
It is assumed that the readers of this manual have general knowledge of
electricity, logic circuits, and microcontrollers.
In the explanations of the operation of the applications, it is also assumed that
readers have sufficient knowledge of Windows.
For the usage and terminology of Windows 98, Windows Me, Windows 2000,
or Windows XP, refer to each Windows manual.
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Conventions Symbols and notation are used as follows:

Weight in data notation : Left is high-order column, right is low order column

Active low notation : xxx (pin or signal name is over-scored) or
/xxx (slash before signal name)

Memory map address: : High order at high stage and low order at low stage

Note  : Footnote for an item marked with Note in the text

Caution  : Information requiring particular attention

Remark  : Supplementary explanation

“  “ : Any character or item on the screen
 OK : Name of button
[  ] : Menu
<  > : Dialog box name

Numeric notation  : Binary . . . XXXX or XXXB
  Decimal . . . XXXX

  Hexadecimal . . . XXXXH or 0x XXXX

Prefixes representing powers of 2 (address space, memory capacity)

 K (kilo): 210 = 1024

 M (mega): 220 = 10242 = 1,048,576

 G (giga): 230 = 10243 = 1,073,741,824

Terminology The meanings of the terms used in this manual are as follows:

Note: The FA adapter is a product of Naito Densei Machida Mfg. Co., Ltd.
If you have any questions about the FA adapter board, contact your local NEC sales
or Distributor.

Term Meaning

FPL
Abbreviation of the on-chip flash memory microcontroller programmer 
PG-FPL

GUI software Windows application used to operate the PG-FPL by using GUI

Target device NEC Electronics on-chip flash memory microcontroller

Target system
User-designed board on which an NEC Electronics on-chip flash 
memory microcontroller is installed 

FP4 connector Abbreviation of a PG-FP4 target connector (type A)

FA adapter
Adapter board used to write programs to an NEC Electronics on-chip 

flash memory microcontroller (FA adapter board)Note
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Chapter 1 Overview

The FPL is a tool that erases, writes, and verifies programs on an NEC Electronics on-chip flash mem-
ory microcontroller on the target board.

1.1 Features

• The FPL is a compact on-chip flash memory microcontroller designed for development.

• The USB interface is available for connection with the host.

• The FPL allows on-board programming without removing the target device from the target system.

• UART only is supported for connection with the target device.

• Device-specific parameters required for writing are read from a parameter file (PRM file).
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Chapter 2 Hardware Installation

2.1 System Requirements 

• OS: A PC supporting Windows 98, Windows Me, Windows 2000, or Windows XP is
needed.
A free space of 2 Mbytes is required on the hard disk to install the GUI software.

• Host machine: The following types of personal computers can be used:

IBM PC/ATTM or compatible
CPU 

PentiumTM 100 MHz or more
RAM 
32 Mbytes or more

 

• Host interface: USB interface that enables communication based on USB (Ver1.1 or later)

• File formats: Program files can be used in Motorola HEX file format or Intel HEX file format.
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Chapter 2 Hardware Installation
2.2 System Configuration

The system configuration of the FPL is shown in Figure 2-1.

Figure 2-1: FPL System Configuration

Notes: 1. se the USB cable (Mini-B type) delivered with IECUBE.

2. The FA adapter is a product of Naito Densei Machida Mfg. Co., Ltd.

The FPL is connected to the host machine via the USB cable (Mini-B type). The FPL is connected to
the user system via the target cable. For the detailed specifications of the target cable and connector,
refer to Chapter 6 Connectors and Cables.
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Chapter 2 Hardware Installation
2.2.1 FPL display specifications, and connector and MODE switch settings

Figure 2-2: Connector and LED Configuration

• Connector for target cable connection : Used to connect the connector of the target cable.

• USB connector : Used to connect the USB cable to be connected to the 
host machine.

• Power LED : Turned on in green when the FPL is connected to the host 
machine.

• Status LED : Blinks in red when the FPL is communicating with the 
target device.

Caution: When the Status LED is blinking, communication with the target device is in
progress. Do not disconnect the target cable and USB cable.

• MODE switch : Switches power to be supplied to the target system.

Setting of the MODE switch

• MODE1: Used when VDD/VDD2 is supplied from the target system.

• MODE2: Used when the FPL supplies power to a target system with 3.3 V VDD.
(The VDD2 pin is placed in the high-impedance state.)

• MODE3: Used when the FPL supplies power to a target system with 5 V VDD.
(The VDD2 pin is placed in the high-impedance state.)

• MODE4: Used when the FPL supplies power to a target system with 5 V VDD 
and 3.3 V VDD2.

Table 2-1: Settings on the rear of the housing

MODE 1 2 3 4

VDD Target 3.3 V 5 V 5 V

VDD2 Target N.C. N.C. 3.3 V

USB connector MODE switch

Power LED Status LED Connector for target
cable connection
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2.2.2 FPL-FA connectors

Figure 2-3: FPL-FA Connector Configuration

• Target connector : Used to connect the tip of the target cable.

• FP4 connector : Used to connect the FA adapter board or target system.

2.2.3 Target system

The target system must be equipped with an interface that complies with the target interface specifica-
tions.
For details of the specifications, refer to Chapter 6 Connectors and Cables.

2.2.4 USB connector

The shape of the USB connector is based on the Mini-B type.
For details of the specifications, refer to Chapter 6 Connectors and Cables.

2.2.5 Target cable

The tip of the target cable can be connected to the header pin of 0.635 × 0.635 mm.
For details of the specifications, refer to Chapter 6 Connectors and Cables.

Target connector

FP4 connector
Component side (front) Solder side (rear)
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Chapter 2 Hardware Installation
2.2.6 Connection procedure

1. Set the MODE switch according to the power supply of the target system.

Caution: Be sure to set the MODE switch before making connections with the host machine
and target system.
If connections are made based on an incorrect setting, this product and target sys-
tem can be damaged.

Figure 2-4: MODE Switch Setting

2. Connect the host machine with the FPL via the USB cable. (Check that the Power LED is turned
on in green.)

Cautions: 1. Be sure to perform this step before making a connection with the target system. 
If connections are made in an incorrect order, this product and target system can
be damaged.

2. If the MODE switch is set to MODE2, MODE3, or MODE4 (power is supplied from
the FPL), the voltage set on the VDD/VDD2 pin is output when the FPL is con-
nected with the host machine.

3A. (When a connection is made with a target system that has a 16-pin connector usable with the FP4
connector)
<1> Connect the tip of the target cable with the target connector of the FPL-FA.

Remark: The FPL-FA is connected with the target cable at the time of shipment.

<2> Check that the power to the target system is not turned on.

Caution: Check that the power to the target system is not turned on before connecting the tar-
get cable. If the target cable is connected after the power to the target system is
turned on, this product can be damaged.

<3> Connect the FP4 connector with the connector installed on the target system.

Caution: When MODE2, MODE3, or MODE4 is set, VDD/VDD2 is output from the FP4 connec-
tor.
Before inserting or removing a device on the target system, be sure to detach the FP4
connector.

<4> Be sure to turn on the power to the target system.
(When MODE2, MODE3, or MODE4 is set, power is supplied from the FPL, so that this step
is not required.)

Set the MODE switch

1: Target /  Target
2: 3.3 V /  N.C.
3: 5 V /  N.C.
4: 5 V /  3.3 V
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Chapter 2 Hardware Installation
• Method of connecting the tip of the target cable with the FPL-FA

Make a connection so that the stamp mark (number) on the tip of the target cable matches 
the number on the FPL-FA board.

Figure 2-5: Connecting the Target Cable with the FPL-FA

3B. (When the FPL is connected with the target system without using the FPL-FA)

<1> Disconnect the FPL-FA from the target cable.
<2> Check that the power to the target system is not turned on.

Caution: Check that the power to the target system is not turned on before connecting the tar-
get cable. If the target cable is connected after the power to the target system is
turned on, this product can be damaged.

<3> Connect the tip of the target cable marked "0.GND" to GND of the target system.

Caution: Be sure to connect "0.GND" at the beginning.
If connections are made in an incorrect order, this product and target system can be
damaged.

<4> Check that the power to the target system is not turned on.
<5> Connect the tip of the target cable marked "1.VDD" to VDD of the target system.
<6> Connect the tip of the target cable marked "2.VDD2" to VDD2 of the target system.

Caution: Be sure to make connections in the order from "0.GND" to "1.VDD" to "2.VDD2" to
"other signals".
If connections are made in an incorrect order, this product and target system can be
damaged.

<7> Connect the tips of other target cables to the target system.
<8> Turn on the power to the target system.

(When MODE2, MODE3, or MODE4 is set, power is supplied from the FPL, so that this step
is not required.)

0 .    G
N

D

Match the number

Tip of target cable
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2.2.7 Disconnection procedure

1. When communication with the target system ends, terminate the GUI software.

2A. (When the FPL is connected with the target system by using the FPL-FA)
<1> Turn off the power to the target system.

(When MODE2, MODE3, or MODE4 is set, power is supplied from the FPL, so that this step
is not required.)

<2> Disconnect the FPL-FA from the target system.

Caution: When MODE2, MODE3, or MODE4 is set, the FPL outputs power at all times. Before
disconnecting the target device, be sure to disconnect the FP4 connector from the
target system.

2B. (When the FPL is connected with the target system without using the FPL-FA)
<1> Turned off the power to the target system.

(When MODE2, MODE3, or MODE4 is set, power is supplied from the FPL, so that this step
is not required.)

<2> Disconnect the tips of the target cables marked "3./RESET", "4.TXD", "5.RXD", and
"6.FLMD0" from the target system.

Caution: Be sure to disconnect the target cables in this order.
If the target cables are disconnected in an incorrect order, the target system or this
product can be damaged.

<3> Disconnect the tip of the target cable marked "2.VDD2" from the target system.
<4> Disconnect the tip of the target cable marked "1.VDD " from the target system.
<5> Disconnect the tip of the target cable marked "0.GND" from the target system.

3. Disconnect the USB cable from the host machine. (Check that the Power LED is turned off.)
4. Disconnect the USB cable from the FPL.
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Chapter 3 Software Installation

3.1 GUI Software Installation

The GUI software allows easy and comfortable access to all features of the FPL.
The installation program is located on the CD-ROM (IECUBE Accessory Disk) delivered with the
IECUBE package. To install the GUI software, use the following procedure:

<1> When using Windows XP, log on as the computer administrator. When using Windows 2000, log
on as the Administrator.

<2> Insert the delivered CD-ROM (IECUBE Accessory Disk) into the CD-ROM drive.

<3> Double-click in the order from "My Computer" to "CD-ROM" to "PG-FPL" to "setup". "setup.exe" is
displayed. Double-click "setup.exe".

Figure 3-1: Setup Folder

Remark: "D:\" on the screen indicates that the CD-ROM drive is set on drive D.

Double-click
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<4> Select a language to be used for installation ("English" in this example), then click OK.

Figure 3-2: Setup Language Selection

<5> Click Next>.

Figure 3-3: Welcome Window

Click

Click
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<6> Read the displayed license agreement carefully, then click Accepted if you accept the agree-
ment. When using the PG-FPL, you need to accept the agreement. If you do not accept the
agreement, click Not accepted to terminate the installation of the software.

Figure 3-4: License Agreement

<7> Check that "Typical" is selected, then click Next>.

Figure 3-5: Setup Type

Remark: By selecting Custom, the GUI software or document only can be installed.
By clicking Browse..., the GUI software installation destination can be changed.
This manual assumes the default installation folder.

Click

Click

Check that “Typical” is selected
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Figure 3-6: Changing the Installation Folder

Figure 3-7: Custom Installation

Specify an installation destination folder path

Click

Check here when installing the GUI software

Check here when installing documents

Click after conforming the check boxes
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<8> Click Next>.

Figure 3-8: Program Folder Selection

<9> Check the current setting, then click Next>. (Program installation starts.)

Figure 3-9: Start of File Copy Operation

Click

Click
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<10> When the screen shown below appears, the installation of the GUI software is completed. Click
Finish to end the installer.

Figure 3-10: Completion of Installation

<11> Upon completion of installation, the following folders are created:

Figure 3-11: Folder Configuration after Installation

Click

 
 

 

 

Program files

C:\

\NECTools 32

\bin

\PG-FPL
[FPL-exe]
[Prrctl.dll]

\DRIVER

\PRM

\FTDI
[Ftdiunin.exe]
Other driver-related files

\doc

\PG-PFL
 [U17271EE1V0UM00.pdf]

Folder specified as the installation destination

GUI software

Driver uninstallation execution file

PRM file storage folder

This manual
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3.2 Driver Installation

When the FPL is used, the driver needs to be installed on the host machine. Install the driver according
to the following procedure:

Installation on Windows 98/Me ................ page 29

Installation on Windows 2000 .................. page 33

Installation on Windows XP ..................... page 39

3.2.1 Installation on Windows 98/Me

<1> When the FPL is connected with the host machine, the FPL is recognized by Plug and Play, and
the wizard for adding new hardware is started. Click Next>.

Figure 3-12: Add New Hardware Wizard (Windows 98)

Click
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<2> The window below is displayed. So, check that "Search for a suitable driver..." is selected, then
click Next>.

Figure 3-13: Search Method (Windows 98)

Click

Check that “Search for a suitable driver...” is selected
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<3> Check the "Specify a location" check box only and enter "C:\Program Files\NECTools32\BIN\PG-
FPL\DRIVER\FTDI" in the address bar, then click Next>.

Figure 3-14: Search Location Specification (Windows 98)

Remark: If the installation destination folder is changed at the time of GUI software installation, enter
"new-folder\BIN\PG-FPL\DRIVER\FTDI".

<1> Check “Specify a location” only

<2> Enter “C:\Program Files\NECTools32\BIN\PG-FPL\DRIVER\FTDI”

<3> Click
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<4> The window below is displayed. Click Next>.

Figure 3-15: Checking Driver to Be Installed (Windows 98)

<5> When the window below is displayed, the installation of the USB driver is completed. 
Click Finish. The installation of the USB Serial Port driver is then automatically performed.

Figure 3-16: Installation Completion (Windows 98)

Click

Click
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3.2.2 Installation on Windows 2000

<1> When the FPL is connected with the host machine, the FPL is recognized by Plug and Play, and
the wizard for finding new hardware is started. Click Next>.

Figure 3-17: Found New Hardware Wizard 1 (Windows 2000)

<2> The window below is displayed. So, check that "Search for a suitable driver..." is selected, then
click Next>.

Figure 3-18: Search Method 1 (Windows 2000)

Click

Click

Check that “Search for a suitable driver...” is selected
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<3> Check the "Specify a location" check box only, then click Next>.

Figure 3-19: Driver File Location 1 (Windows 2000)

<4> Enter "C:\Program Files\NECTools32\BIN\PG-FPL\DRIVER\FTDI" in the address bar, then click
OK.

Figure 3-20: Address Specification 1 (Windows 2000)

Remark: If the installation destination folder is changed at the time of GUI software installation, enter
"new-folder\BIN\PG-FPL\DRIVER\FTDI".

Click

Check that “Specify a location” only is checked

Click

Enter “C:\Program Files\NECTools32\BIN\PG-FPL\DRIVER\FTDI”
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<5> Click Next>.

Figure 3-21: Driver File Search 1 (Windows 2000)

<6> Click Finish to complete the installation of the USB driver.

Figure 3-22: USB Driver Installation Completion 1 (Windows 2000)

Click

Click
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<7> Proceed to the installation of the USB Serial Port driver. Click Next>.

Figure 3-23: Found New Hardware Wizard 2 (Windows 2000)

<8> The window below is displayed. So, check that "Search for a suitable driver..." is selected, then
click Next>.

Figure 3-24: Search Method 2 (Windows 2000)

Click

Click

Check that “Search for a suitable driver...” is selected
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<9> Check the "Specify a location" check box only, then click Next>.

Figure 3-25: Driver File Location 2 (Windows 2000)

<10> Enter "C:\Program Files\NECTools32\BIN\PG-FPL\DRIVER\FTDI" in the address bar, then click
OK.

Figure 3-26: Address Specification 2 (Windows 2000)

Remark: If the installation destination folder is changed at the time of GUI software installation, enter
"new-folder\BIN\PG-FPL\DRIVER\FTDI".

Click

Check that “Specify a location” only is selected

Enter “C:\Program Files\NECTools32\BIN\PG-FPL\DRIVER\FTDI”

Click
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<11> Click Next>.

Figure 3-27: Driver File Search 2 (Windows 2000)

<12> Click Finish to complete the installation of the USB driver.

Figure 3-28: USB Driver Installation Completion 2 (Windows 2000)

Click

Click
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3.2.3 Installation on Windows XP

<1> When the FPL is connected with the host machine, the FPL is recognized by Plug and Play, and
the wizard for finding new hardware is started. Check that "Install from a list or specific..." is
selected, then click Next>.

Figure 3-29: Found New Hardware Wizard 1 (Windows XP)

Check that “Install from a list or specific...” is selected
Click
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<2> Check that "Search for the best driver in these locations." is selected. Check the "Include this
location in the search:" check box and enter 
"C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI" in the address bar, then click Next>.

Figure 3-30: Search Location Specification 3 (Windows XP)

<3> As shown below, "has not passed Windows Logo testing to verify its compatibility with Windows
XP." is displayed. Click Continue Anyway.

Figure 3-31: Windows XP Logo Testing 3 (Windows XP)

<1> Check that “Search for the best 
       driver in these locations” is selected

<2> Check “Include this location
       in the search:” only

<3> Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI” <4> Click

Click
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<4> When the window below is displayed, the installation of the USB driver is completed. 
Click Finish.

Figure 3-32: USB Driver Installation Completion 1 (Windows XP)

<5> Proceed to the installation of the USB Serial Port driver. Click Next>.

Figure 3-33: Found New Hardware Wizard 2 (Windows XP)

Click

Check that “Install from a list or specific...” is selected

Click
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<6> Check that "Search for the best driver in these locations." is selected. Check the "Include this
location in the search:" check box and enter
"C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI", then click Next>.

Figure 3-34: Search Location Specification 2 (Windows XP)

<7> As shown below, "has not passed Windows Logo testing to verify its compatibility with Windows
XP." is displayed. Click Continue Anyway.

Figure 3-35: Windows XP Logo Testing 2 (Windows XP)

<1> Check that “Search for the best 
       driver in these locations” is selected

<2> Check “Include this location
       in the search:” only

<3> Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI”

<4> Click

Click
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<8> When the window below is displayed, the installation of the USB driver is completed. 
Click Finish.

Figure 3-36: USB Serial Port2 Driver Installation Completion (Windows XP)

Click
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3.3 Confirmation of USB Driver Installation

After installing the two types of drivers, check that the drivers have been installed normally, according to
the procedure below. When using the FPL, the information to be checked here is needed.

By clicking the "Device Manager" tab, check that the drivers are installed normally.

Figure 3-37: Device Manager

For Windows 98/Me

Caution: Do not select Update and Erase when communicating with the target device.

For Windows 2000/XP

Caution: Do not perform "Hardware Modification Scan" when communicating with the target
device.

Remark: In the GUI port list box, the same communication port as COM? of USB Serial Port (COM?)
needs to be selected.

If the drivers above are not displayed, or the mark "×" or "!" is prefixed, refer to 
Chapter 9 Troubleshooting.

Check that “USB Serial Port
(COM?)” is present

Check that “USB High Speed
Serial Converter” is present
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3.4 Uninstallation

3.4.1 Driver uninstallation

The driver uninstallation program is installed on the host machine when the GUI software is installed.
Use the procedure below for driver uninstallation.

<1> When using Windows XP, log on as the computer administrator. When using Windows 2000, log
on as the Administrator.

<2> Double-click in the order from "My Computer" to "(C:)" to "Program Files" to "NECTools32" to "bin"
to "PG-FPL" to "DRIVER" to "FTDI". "Ftdiunin.exe" is displayed. Double-click "Ftdiunin.exe".

Figure 3-38: Driver Uninstallation

Double-click
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<3> Click Continue.

Figure 3-39: Driver Uninstaller

<4> Click Finish to complete driver uninstallation.

Figure 3-40: Completion of Driver Uninstallation

Caution: If the GUI software is uninstalled earlier, "Ftdiunin.exe" is also deleted. At this time,
delete "USB Serial Port (COM?)" and "USB High Speed Serial Converter" from Device
Manager manually.

Click

Click
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3.4.2 GUI software uninstallation

The uninstallation program is placed on the CD-ROM (IECUBE Accessory Disk) delivered with the
IECUBE package (the same program as the installer). For GUI software uninstallation, use the proce-
dure below.

<1> When using Windows XP, log on as the computer administrator. When using Windows 2000, log
on as the Administrator.

<2> Insert the delivered CD-ROM (IECUBE Accessory Disk) into the CD-ROM drive.

<3> Double-click in the order from "My Computer" to "CD-ROM" to "PG-FPL" to "setup". "setup.exe" is
displayed.
Double-click "setup.exe".

Figure 3-41: Setup Folder

Remark: "D:\" on the screen indicates that the CD-ROM drive is set on drive D.

Double-click
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<4> Select a language to be used for installation ("English" in this example), then click OK.

Figure 3-42: Setup Language Selection

<5> Select "Remove" then click Next>.

Figure 3-43: Program Modification

Click

Click

Select “Remove”
48 Preliminary User’s Manual U17271EE1V0UM00



Chapter 3 Software Installation
<6> Click OK.

Figure 3-44: Confirmation of File Deletion

<7> Click Finish to complete the deletion of the GUI software.

Figure 3-45: Completion of Maintenance

Click

Click
49Preliminary User’s Manual U17271EE1V0UM00



[MEMO]
50 Preliminary User’s Manual U17271EE1V0UM00



Chapter 4 Using The GUI Software

4.1 Introduction

Before you start using the FPL, download the parameter file (.PRM) for the target device to the PRM
folder.

• <Downloading the parameter file>

The parameter file is not delivered with the FPL software package.
Download the parameter file for the PG-FP4 from the following NEC Electronics Web site:

http://www.ee.nec.de/update 

Copy the parameter file downloaded from the NEC Electronics Web site into sub-directory 
<FPL.EXE-install-path>\PRM created during GUI software setup (refer to Chapter 3 Software Instal-
lation).

4.2 Starting up the GUI Software

• GUI software startup

Select FPL.EXE from the start menu to start the FPL GUI software.

When the GUI software is started normally, the following screen appears.

Figure 4-1: GUI Software Main Window

Menu bar

Toolbar

Status bar

Programmer
parameter
window

Action log window
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This window consists of the following items:

4.3 Toolbar

The toolbar contains buttons for starting the important procedures of the FPL.

Name Display Information

Menu bar
(displayed at the top)

Displays menu items executable by the FPL

Toolbar
(displayed under the menu bar)

Displays frequently used commands as icons

Action log window
(displayed under the toolbar)

Displays an FPL action log

Programmer parameter window
(displayed to the right of the action log window)

Displays programming parameter settings

Status bar Displays status

Table 4-1: Toolbar Buttons

[Device] → [Setup] button

[File] → [Load] button

[Device] → [Blank Check] button

[Device] → [Erase] button

[Device] → [Program] button

[Device] → [Verify] button

[Device] → [Autoprocedure (EPV)] button
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4.4 Menu Bar

Depending on the actual device status and device type, some menu items may be enabled or disabled.

4.4.1 [File] menu

Clicking the [File] menu displays the pull-down menu as shown below.
This menu mainly contains commands related to file operation.

Figure 4-2: [File] Menu

(1) [Load] command 

Figure 4-3: HEX File Selection Window

The [Load] command allows you to select a program file.
The selected program file is programmed into the flash memory of the device by executing
the [Program] command or [Autoprocedure (EPV)] command.
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The file selection window for program loading displays the most recently used directory to which a
user program has been loaded. After a user program is loaded, a checksum calculation is made
and the result is displayed in the programmer parameter window.
[Open button]
Selects a user program as a program to be written to the target device.

[Cancel button]
Closes the window without selecting a program.

(2) [Quit] command

The [Quit] menu is the command for terminating the FPL GUI software. Clicking  × on the right side
of the task bar also terminates the FPL GUI software.

User settings are saved in the FPL.ININote file, so that the GUI software starts up next time with
the same settings.

Note: FPL.INI is created in the Windows folder when Windows 98, Windows Me, or Windows XP is
used.
When Windows 2000 is used, FPL.INI is created in the Winnt folder.

4.4.2 [Device] menu

Clicking the [Device] menu displays the pull-down menu as shown below.
This menu mainly contains commands for programming operations such as deletion, programming, and
verification on the target device.

Figure 4-4: [Device] Menu
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(1) [Blank Check] command  

(2) [Erase] command 

Caution: During erase operation, the Status LED is not turned on. Until the GUI software dis-
plays "Erase finished", do not disconnect the target cable and USB cable. Otherwise,
the target device can be damaged.

(3) [Program] command 

(4) [Verify] command 

The [Blank Check] command allows you to make a blank check on the target device con-
nected to the FPL. If the flash memory of the target device is erased, a blank check is termi-
nated normally. If the flash memory is not completely erased, the indication "not blank" is
provided. Before starting programming, erase the flash memory of the target device. 

The [Erase] command erases the flash memory of the target device connected to the FPL.
While the flash memory is being erased, the progress status is displayed in the action log
window to indicate programmer operation. 
The execution on the [Blank Check] command before the [Erase] command is executed fol-
lows the setting of 'Command options' of the Advance tab displayed by selecting 
[Device] → [Setup]. 
Upon completion of [Erase] command execution, the GUI software displays the result of
executing the command on the target device. 

The [Program] command sends a specified user program to the target device and writes the
program to the flash memory. 
The execution of Verify operation for detecting an error in user program communication from
the FPL to the target device after the execution of the [Program] command follows the 
setting of the 'Command options' on the Advance tab displayed by selecting 
[Device] → [Setup].
During programming, the progress status is displayed in the action log window to indicate
programmer operation. This progress status display window displays the progress status on
target device programming by percentage.
Upon completion of [Program] command execution, the GUI software displays the result of
executing the command on the target device.

The [Verify] command sends a specified user program to the target device connected with
the FPL, and performs verification against the data written to the flash memory of the target
device. 
During verification, the progress status is displayed in the action log window to indicate pro-
grammer operation. This progress status display window displays the progress status of tar-
get device verification by percentage.
Upon completion of [Verify] command execution, the GUI software displays the result of exe-
cuting the command on the target device.
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(5) [Security] command

This command is not supported.

(6) [Checksum] command

The [Checksum] command reads the checksum value of the target device connected with the
FPL.
This value differs from the value displayed in the parameter window of the main window.

(7) [Autoprocedure (EPV)] command 

(8) [Signature read] command

The [Signature read] command reads the signature information (device name, flash memory infor-
mation, and so forth) of the target.

The [Autoprocedure (EPV)] command executes the [Erase] command and [Program] com-
mand in succession. 
When a user program is to be resent to the target device for comparison with the data writ-
ten to the flash memory of the target device because of a user program communication
error, execute the [Program] command by selecting [Device] → [Setup] and specifying
'Command options' on the Advance tab, then set the automatic execution of the [Verify]
command.
During EPV execution, the progress status is displayed in the action log window to indicate
programmer operation. For a selected command, its execution operation, and messages,
refer to Chapter 5 Example of Use.
Upon completion of [Autoprocedure (EPV)] command execution, the GUI software displays
the result of executing the command on the target device.
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Chapter 4 Using The GUI Software
(9) [Setup] command 

(a) Standard setup

This menu is used to set the environment for rewriting the flash memory of the target device.
The mode of communication with the target, the operating clock, and so forth differ depending on
the device used. For details, refer to the manual of the device used, when making settings.
The window shown below is opened.

Figure 4-5: Device Setup Window - Standard

This window shows all basic options that can be set in accordance with the user environment and
target device.

[OK button]
Clicking the OK button saves the settings on the Standard and Advance menus and closes the
window.

[Cancel button]
Clicking the Cancel button closes the window without saving the settings on the Standard and
Advance menus.

The [Setup] menu allows you to make settings related to flash memory rewriting according
to the user environment and to set command options. Each time the GUI software is started,
the most recently used parameter file (.PRM) is read and the settings are displayed. The
[Setup] menu allows you to modify the settings of items other than those items consisting of
shadowed characters according to the user environment. 
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Chapter 4 Using The GUI Software
<1> Parameter file
This file holds parameters and timing data required to rewrite the flash memory of the target
device. Do not modify the data in the parameter file because the data is related to the guarantee of
rewrite data.
The parameter file is protected by the checksum function. If the checksum result indicates an
error, the FPL does not accept the parameter file.

Figure 4-6: Setup Window - Parameter File Selection

Figure 4-7: Parameter File Selection Window

[PRM File Read button]
A window for specifying a parameter file is displayed. Specify a desired file then click Open.
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Chapter 4 Using The GUI Software
<2> Communication interface to device
"Communication interface to device" is used to select a channel for communication between the
FPL and host machine.

Figure 4-8: Setup Window - Communication interface to device

[Port list box]
Select a channel for communication between the FPL and host machine.

• COM1 to COM16

Remark: Selectable ports can be checked using Device Manager. For details, refer to 
3.3 Confirmation of USB Driver Installation.

[Speed list box]
Select a communication rate for the selected communication channel from the following:

• 9600 bps 

• 19200 bps 

• 38400 bps 

Remark: For selectable communication rates, refer to the user's manual of the device used.
59Preliminary User’s Manual U17271EE1V0UM00



Chapter 4 Using The GUI Software
<3> Supply oscillator
"Supply oscillator" is used to select a clock that determines programming, data transfer, and a
transfer rate.

Figure 4-9: Setup Window - Supply Oscillator Selection

[Frequency box]
Sets the clock frequency of the target system.
The range of operating frequency varies from one device to another. So, check the specifications
of the device used before making a setting.

[Multiply rate]
Specifies the division rate or multiplication rate of the target device.
If the target device has an on-chip PLL circuit, enter a division rate or multiplication rate according
to the use environment.
The selectable division rate or multiplication rate differs depending on the device. Check the spec-
ifications of the device used before making a setting.
If the target device does not have an on-chip PLL circuit, select "1.0".
On the initial screen, the default setting is displayed according to the parameter file.
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Chapter 4 Using The GUI Software
<4> Operation Mode
The setting of "Operation Mode" may divide the flash memory of some target devices into blocks
or areas.
This menu is used to select an operation mode of the flash memory. Some devices do not have
the block and area division modes, and some devices have only one of the modes. In these cases,
a nonexistent mode is unchoosable.

Figure 4-10: Setup Window - Operation Mode

[When Chip is selected]
The entire flash memory area of the target device is subject to rewrite processing.

[When Block is selected]
Specify the Block number range subject to rewrite processing by using Start/End.
The Start/End list boxes display the Block numbers where the flash memory of the target device is
configured.

[When Area is selected]
Specify the Area number range subject to rewrite processing by using Start/End.
The Start/End list boxes display the Area numbers where the flash memory of the target device is
configured.

[Show Address check box]
Specify whether numbers or addresses are displayed in the Start/End list boxes.
If this check box is checked, addresses are displayed.
If this check box is not checked, numbers are displayed.
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Chapter 4 Using The GUI Software
(b) Advance setup

The Advance setup menu is used to specify the command options and security flag settings.
When "Advance" is clicked, the following window is displayed:

Figure 4-11: Device Setup Window - Advance
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Chapter 4 Using The GUI Software
<1> Command options
This dialog box is used to specify the FPL flash processing command options.

Figure 4-12: Setup Window - Command options

[Blank check before Erase check box]
If this check box is checked, blank check is made before the Erase command or EPV command is
executed.
If the result of a blank check indicates OK, erase processing is not executed.

[Read verify after Program check box]
If this check box is checked, write data is sent from the programmer after execution of the Program
command and EPV command, then the data is verified against the data written to the flash 
memory.

[Security flag after Program check box] Not usable

[Checksum after Program check box]
If this check box is checked, the flash memory checksum value of the target device is read from
the target device after execution of the Program command and EPV command.
This value differs from the value displayed in the parameter window of the main window.

<2> Security flag settings Not usable
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Chapter 4 Using The GUI Software
4.4.3 [View] menu

Clicking the [View] menu displays the pull-down menu shown below.
This menu contains commands for setting whether to display the toolbar and status bar.

Figure 4-13: [View] Menu

(1) [Toolbar] command

Checking the [Toolbar] command displays the toolbar. Unchecking the command hides the toolbar.

(2) [Status Bar] command

Checking the [Status Bar] command displays the status bar. Unchecking the command hides the
status bar.
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Chapter 4 Using The GUI Software
4.4.4 [Help] menu

Clicking the [Help] menu displays the following pull-down menu:

Figure 4-14: [Help] Menu

(1) [About FPL] command

The [About FPL] command opens the program entry window as shown below and indicates the
version.
Clicking OK terminates the display.

Figure 4-15: About FPL Window
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Chapter 4 Using The GUI Software
4.5 Programmer Parameter Window

This window displays the settings of the programming parameters.

Figure 4-16: Programmer Parameter Window

[Device]
Updated after communication with the target device to display information about the target device.

[Parameter file]
Updated after [Setup] command execution to display information about a read parameter file.

[Load file]
Updated after [Load] command execution to select information about a selected program file.

[Connection to device]
Updated after [Setup] command execution to display information about the connection with the tar-
get device.
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Chapter 5 Example of Use

This chapter explains a series of basic operations of the PG-FPL with the GUI software, taking a case
where the µPD70F3266 is used as the target device as an example. This chapter covers how to start
the system, execute the EPV command, and program the target device.
For the other commands and applications, refer to Chapter 4 Using The GUI Software.

Series of operations described in this chapter
The conditions of the series of operations described in this chapter are as follows:

Target system
Target device : µPD70F3266
Clock : 5 MHz
Voltage level : 3.3 V
Communication : UART CH0

FPL
Parameter file : 70F3266_CSI0.PRM
Clock setting : 5 MHz Multiplied by 4
Port : COM2 (38400 bps)
MODE switch : 2 (VDD: 3.3, VDD2: N.C)
Operation mode : Chip
Write HEX : FPL_TEST.HEX
Option setting : • Read verify after Program

• Blank check before Erase

(1) Installing the GUI software

Install the FPL GUI software in the host machine you are using, by referring to 
Chapter 3 Software Installation (if the software has not been installed yet).

(2) Installing the driver

Install the USB driver in the host machine you are using, by referring to 
Chapter 3 Software Installation (if the driver has not been installed yet).

(3) Installing the parameter file

Copy the parameter file for the µPD70F3266 to the hard disk and install it in 
<FPL-install-path>\PRM.
Download the parameter file from the following:

http://www.ee.nec.de/update 
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Chapter 5 Example of Use
(4) Connecting and starting the system

<1> Set the MODE switch to "2".
<2> Connect the FPL with the host machine via the USB cable.
<3> Check that the Power LED is turned on.
<4> Check that the power to the target system is not turned on, then connect the FPL with the target

system via the target cable.
<5> Start the GUI software.

Figure 5-1: GUI Software Startup Screen
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Chapter 5 Example of Use
(5) Setting the programming environment

<1> Select [Device] → [Setup] from the menu bar.
<2> The Standard dialog box for device setup is activated.

Figure 5-2: <Standard Device Setup> Dialog Box

<3> Click PRM File Read to open the parameter file selection window.
In this case, select the parameter file for the µPD70F3266 then click Open.

Figure 5-3: Parameter File Selection
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Chapter 5 Example of Use
<4> From the Port list box, select the communication port that matches the host machine being used.

Figure 5-4: Port Selection

Remark: Selectable ports can be checked using Device Manager. For details, refer to 
3.3 Confirmation of USB Driver Installation.
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Chapter 5 Example of Use
<5> Set the other displayed setting items to match the programming environment being used.
In particular, set "Supply oscillator" according to the specifications of the selected device.
In "Operation Mode", specify a flash memory range subject to operation. Here, the following set-
tings are assumed:

Figure 5-5: <Standard Device Setup> Dialog Box after Setting
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Chapter 5 Example of Use
<6> Switch to the Advance dialog box.

Figure 5-6: <Advance Device Setup> Dialog Box 

<Command options> 
Blank check before Erase : Checked
Read verify after Program : Checked
Checksum after Program : Not checked
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Chapter 5 Example of Use
<7> Click the OK button. The GUI software sets the parameters.
When the settings have been completed, the following screen is displayed:

Figure 5-7: Completion of Parameter Setting

“PRM File Read OK” is displayed

The display is updated
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Chapter 5 Example of Use
(6) Selecting an user program

<1> Select [File] → [Load].
<2> Select a program file to be written to the target device, then click Open.

Figure 5-8: After Downloading

The display is updated

“Success read HEX file” is displayed
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Chapter 5 Example of Use
(7) [Autoprocedure (EPV)] command execution

Select [Device] → [Autoprocedure (EPV)] from the menu bar.
When the [Autoprocedure (EPV)] command is executed, Blank Check → Erase → Program →
Verify are executed sequentially for the µPD70F3266. In this example, Read verify after Program
is checked. So, after the execution of the [Autoprocedure (EPV)] command, verification is per-
formed to check if communication between the FPL and the target device has been performed
normally.

Figure 5-9: After EPV Execution

(8) Terminating the system

<1> If other devices need not be programmed, select [File] → [Quit] to terminate the GUI software. 
All settings executed so far are saved in the FPL.INI file, so that those settings can be reused
when the GUI software is restarted.

<2> Disconnect the target cable from the target system.
<3> Disconnect the USB cable from the FPL.

(9) Restart

When the system is restarted, the same screen as shown in Figure 5-7 appears.

“... finish” is displayed
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Chapter 6 Connectors and Cables

6.1 USB Connector (FPL)

Figure 6-1: USB Mini-B Type Host Connector Pin Configuration

Connector model: UX60A-MB-5ST (manufactured by Hirose Electric)

For connection with the host machine, use a USB cable (Mini-B type).
For confirmation, NEC Electronics used only the USB cable delivered with IECUBE.

Table 6-1: Pin Configuration of USB Connector

USB Connector FPL Signal Name

1 VCC_USB

2 USBDM

3 USBDP

4 N.C.

5 GND

1 5
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Chapter 6 Connectors and Cables
6.2 Target Cable Connection Connector (FPL)

Figure 6-2: Target Connector Pin Configuration

Connector model: DF3A-8P-2DSA (manufactured by Hirose Electric)

Table 6-2: Pin Configuration of Target Cable Connection Connector

Target Connector FPL Signal Name

1 GND

2 VDD

3 VDD2

4 RESET

5 TXD

6 RXD

7 FLMD0

8 FLMD1

8 1
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Chapter 6 Connectors and Cables
6.3 Target Cable Specifications

Figure 6-3: External View of Target Cable

Applicable header pin specification: 0.635 × 0.635 mm (length: 6 mm)
NEC Electronics confirmed that the header pin below is usable.

Honda Tsushin Kogyo: FFC-7AMEP1

Table 6-3: Pin Configuration of Target Cable

Cable Specification
Display

Specification

No. 1 Black GND 0. GND

No. 2 Brown VDD 1. VDD

No. 3 Red VDD2 2. VDD2

No. 4 Orange RESET 3. RESET

No. 5 Yellow TXD 4. TXD

No. 6 Green RXD 5. RXD

No. 7 Blue FLMD0 6. FLMD0

No. 8 Purple FLMD1 7. FLMD1
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Chapter 6 Connectors and Cables
6.4 Target Connector (FPL-FA)

Figure 6-4: External View of Target Connector

Connector model: FFC-7AMEP1 (manufactured by Honda Tsushin Kogyo)

Table 6-4: Pin Configuration of Target Connector

Target Connector
FPL-FA Signal 

Name

0 GND

1 VDD

2 VDD2

3 RESET

4 TXD

5 RXD

6 FLMD0

7 FLMD1

0 7
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Chapter 6 Connectors and Cables
6.5 FP4 Connector (FPL-FA)

Figure 6-5: External View of FP4 Connector

Connector model: 8516-4500SC (manufactured by Sumitomo 3M)

Note: Receptacle connector which fits FP4 connector is 7616-5002SC 
(manufactured by Sumitomo 3M).

Table 6-5: Pin Configuration of FP4 Connector

FP4 Connector
FPL-FA Signal 

Name

1 GND

2 RESET

3 RXD

4 VDD

5 TXD

11 VDD2

12 FLMD1

14 FLMD0

6, 7, 8, 9, 10, 13, 15, 16 N.C.

1

2

15

16
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Chapter 6 Connectors and Cables
6.6 List of Interface Connections

Figure 6-6: Target Interface

Remark: 1 - Target cable connector, pin 8
2 - Target cable FLMD1, pin 7
3 - Target connector CN1, pin 7
4 - FP4 connector CN2, pin 12

Table 6-6: List of Interface Connections

Signal Name
Target Cable Connection 

Connector
Tip of Target Cable

Target Connector
CN1

FP4 Connector
CN2

GND 1 0. GND 0 1

VDD 2 1. VDD 1 4

VDD2 3 2. VDD2 2 11

RESET 4 3. RESET 3 2

TXD 5 4. TXD 4 5

RXD 6 5. RXD 5 3

FLMD0 7 6. FLMD0 6 14

FLMD1 8 7. FLMD1 7 12

PG-FPL Target cable FPU-FA

1 2 3 4
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Chapter 7 Notes on Target System

This chapter explains the basic notes on the target system for rewriting the flash memory in the micro-
controller by using FPL.

CPU Pin Design Proposal

RESET

Do not connect the RESET signal generator on the target system to the RESET signal of the FPL. 
Otherwise, a signal conflict occurs. To avoid the conflict, isolate the RESET signal generator from 
the RESET signal of the FPL.
Do not generate RESET when the FPL is connected. This must be especially noted in a system 
that uses an external watchdog timer.

Make a connection to the RESET pin of the device at a point where the RESET signal of the FPL 
and the RESET signal of the target system assume the same state.
     Example of correct connection:

Avoid the following RESET signal connection:

• Connection to a point where the RESET rise time of the target device is slower than the 
RESET rise time of the FPL
Example of incorrect connection:

     It takes time for the RESET pin of the CPU to go high after the RESET level of the FPL goes 
     from low to high.

CPU

FPL RESET

RESET

CPU

OCFPL RESET

RESET
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Chapter 7 Notes on Target System
CPU Pin Design Proposal

RESET
• Connection to a point where the RESET pin of the target device cannot be driven to low level 

by the RESET signal of the FPL
     Example of incorrect connection

     When RESET of the FPL is driven low, the voltage level at point A does not fall.

Serial 
interface pin

If the CPU port used by the FPL is connected to the input of an external device, and that device 
malfunctions, disconnect the external device or make it output high impedance.

Example:

If the CPU port used by the FPL is connected to the output of an external device, and a signal con-
flict occurs, disconnect the external device.

Example:

Others

For the unused pins, refer to the user's manual of the device.
Some devices have pins that must be processed differently. For these pins as well, refer to the 
user's manual of the device.

Example of pins processed differently:
MODE
CKSEL
REGOUT
REGIN, etc.

A

CPU

FPL RESET

RESET

Bad effect

FP4
connector

Input

External device

CPU

SO/TXD

FP4
connector

Conflict

Output

External device

CPU

SI/RXD
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Chapter 7 Notes on Target System
The following shows an example of the interface circuit of UART (asynchronous communication port).
Refer to the above design proposal for the pin processing of the device to be used.

Figure 7-1: Example of UART Interface Circuit

Cautions: 1. The FPL operates normally if a direct connection between PG-FPL and the device
is established. No additional external components like pull up or pull down resis-
tors need to be connected to the signals between PG-FPL and the device.

2. Special care have to be taken if pull up or pull down resistors are attached to any
signal between PG-FPL and the device.
PG-FPL drive some signals by internal pull up or pull down resistors to
high or low level. Especially the FLMD0 (4.7 K pull up), FLMD1 (100 pull down),
TXD (~5 K pull up), RESET (~5K pull up) signals may be corrupted by an external
circuitry.
Please check the compatibility of external components to the internal circuitry
shown on page 90 of Chapter 8 Circuit Diagrams.

GND
RESET
RXD
VDD
TXD
N.C.

N.C.

N.C.

N.C.
N.C.
N.C.
N.C.

N.C.

VDD2

FLMD1

FLMD0

RESET
RXD

TXD

FLMD1

FLMD0
VDD

VSS

X1

X2

C

C

Y

VCC

VCC VCC VCC

Jumper

R R R

R R IC

Microcontroller

User reset circuit
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Chapter 8 Circuit Diagrams

Figure 8-1: Circuit Diagram of FPL-FA

$
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Chapter 8 Circuit Diagrams
Figure 8-2: Circuit Diagrams of Main FPL Unit (1/3)
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Chapter 8 Circuit Diagrams
Figure 8-2: Circuit Diagrams of Main FPL Unit (2/3)
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Chapter 8 Circuit Diagrams
Figure 8-2: Circuit Diagrams of Main FPL Unit (3/3)

(c) Target Interface Section
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Chapter 9 Troubleshooting

9.1 Trouble during Setup

(1) In driver installation, recognition based on Plug and Play is disabled.

Cause:
The USB connector may not be inserted normally into the USB port of the personal computer.
Action:
Check that the USB connector is inserted fully into the USB port of the personal computer.
Alternatively, disconnect the USB connector, then insert the USB connector again after a while.

(2) The driver file cannot be found at a specified location.

Cause:
The GUI software of the FPL may not be installed correctly.
Action:
Install the GUI software again by referring to 3.1 GUI Software Installation.

(3) In checking by Device Manager, "USB Serial Port" or "USB High Speed Serial Converter" is 
not displayed. Alternatively, the "!" or "×" is prefixed.

Cause:
The USB connector may not be inserted normally into the USB port of the personal computer.
Action:
Check that the USB connector is inserted fully into the USB port of the personal computer.
Alternatively, disconnect the USB connector from the USB port, then insert the USB connector
again after a while.

Cause:
The driver may not be installed correctly.
Action:
<1> When this product is connected to the personal computer, right-click the driver marked with

"!" or "×".
Click Erase when displayed.

<2> On Device Manager, execute [Hardware Modification Scan].
<3> Install the driver again with Plug and Play.

Cause:
The device may not be recognized (in the case of connection with the USB hub).
Action:
Try the following:

• Disconnect the USB connector, then insert the USB connector again.

• Connect the USB connector to another port of the USB hub.

If the same symptom occurs, do not use the USB hub, but directly connect the connector to the
USB port of the personal computer.
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Chapter 9 Troubleshooting
9.2 Trouble during Operation (Main Unit)

(1) When a connection is made to the personal computer, the Power LED is not turned on.

Cause:
This product or the USB port of the personal computer may be destructed.
Action:
Try a connection to another personal computer.

(2) When communication is not performed with the target device, the Status LED is turned on.

In accordance with the specifications of this product, the Status LED may be turned on even when
communication is not performed with the target device.
The Status LED blinks when communication is performed with the target device.

(3) When this product is connected with a personal computer, the "Add New Hardware Wizard" 
screen is displayed.

Cause:
If the USB connector of this product is inserted not into the USB port used at the installation time
but into another USB port, this product may be recognized as a new hardware item.
Action:
Install the driver by referring to 3.2 Driver Installation.
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9.3 Trouble during Operation (Communication)

(1) Communication with the target device is disabled.

Cause:
The driver may not be installed correctly.
Action:
Check if "USB Serial Port" and "USB High Speed Serial Converter" are installed correctly by refer-
ring to 3.2 Driver Installation.

Cause:
The Port list box may not be set correctly.
Action:
Set the port checked using Device Manager.

Cause:
An incorrect connection may be made between the target cable and target system.
Action:
Check if the connection is correct.
Pay special attention to the following connections because the connections are confusing:

TXD of target cable  → RXD of target device
RXD of target cable  ← TXD of target device

Cause:
The power or clock may not be supplied to the target device correctly.
Action:
<1> Check that the clock is supplied on the target system.
<2> Check that the power is supplied on the target system.

If the power is supplied from the FPL, check if the setting of the MODE switch is correct.

Cause:
The PRM file selected in [Device Setup] may be incorrect.
Action:
Use a PRM file that matches the target device.
For information about PRM files, refer to Chapter 4 Using The GUI Software.

Remark: A parameter file (.prc) for FlashPro3 is unusable.

Cause:
The setting of "Supply oscillator" in [Device Setup] may be incorrect.
Action:
Make a correct setting according to the specifications of the target device and the use environ-
ment.

Cause:
The setting of the Speed list box in [Device Setup] may be incorrect.
Action:
Make a correct setting according to the user's manual of the target device.

Cause:
The power supply capacity of the USB port of the personal computer may be low (when MODE2,
MODE3, or MODE4 is selected).
Action:
Try using another personal computer or supply power from the target system by selecting MODE1.
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Chapter 9 Troubleshooting
Cause:
Security may be set with another on-chip flash memory microcontroller programmer (such as PG-
FP4).
Action:
Check that security is not set.

(2) During erase operation, the Status LED does not blink.

In accordance with the specifications of this product, the Status LED may not blink during erase
operation.
To confirm the erasure status, check the following message in the action log window of the GUI
software:

Message during erase operation: "Flash Erasing..."
Message for completion of erasure: "chip erase finish." or "all block erase finish."

Cause:
The power supply capacity of the USB port of the personal computer may be low (when MODE2,
MODE3, or MODE4 is selected).
Action:
Try using another personal computer or supply power from the target system by selecting MODE1.
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Chapter 10 Appendix

10.1 Hardware Specifications

Note: The 5-V output of this product depends on the USB port of the host machine. If the supply
power of the USB port is unstable or does not satisfy the specifications of the target device, use
MODE1 (power supply from the target system).

Table 10-1: Specifications of the Main Unit

MIN. TYP. MAX.

Operating supply voltage (VDD_USB) 4.4 V 5.0 V 5.25 V

Supply current (VDD_USB) 500 mA

Current consumption of the main unit 35 mA

5.0-V outputNote 4.2 V 4.8 V 5.05 V

3.3-V output 3.0 V 3.3 V 3.6 V

Target VDD voltage 2.7 V 5.5 V

VDD output current 200 mA

VDD2 output current 200 mA
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10.2 Dimensions

External view of the main FPL unit

Figure 10-1: External View of the Main Unit

Unit [mm]
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External view of the FPL-FA

Figure 10-2: External View of the FPL-FA

Unit [mm]
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Target cable

Figure 10-3: External View of Target Cable

Figure 10-4: External View of Target Cable Tip

Connector model: PS-SF-C2-1 (manufactured by JAE)

Unit [mm]

30 [mm]120 [mm]

Connector Tip
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Chapter 10 Appendix
Warranty and Support

• Warranty
This product (including hardware and software) is replaced free of charge in the case of an initial
failure only.
No warranty is provided for failures other than initial failures. 

• Support
No support is provided for this product.
Visit the following site to obtain the latest information about this product:

Site: http://www.ee.nec.de/update 
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